Licensing and Copyright Agreement

This software is Copyright ©2008-2020 TED and ©TRI-EDRE.
Except as permitted under copyright law, no part of the program or this manual may be reproduced or distributed in any form or by any means without the prior written permission of TRI-EDRE.
The program, and this manual, are licensed only for individual use on a single computer. You are permitted by law to make working copies of the software program, solely for your own use. No copy (original or working) may be used while any other copy is in use.
If you ever sell, lend, or give away the original copy of this Software program, all working copies must also be sold, lent, or given to the same person, or destroyed.

Limited Warranty

TRI-EDRE warrants to you that the Software will perform substantially in accordance with the Documentation for the ninety (90) day period following the date of delivery of the Software to you. If the Software fails to meet the specifications of the warranty set forth above, TRI-EDRE liability and your exclusive remedy will be replacement of the CD or a reasonable effort to make the product meet the above warranty specification. Except for the above express limited warranties, TRI-EDRE makes and you receive no warranties or guarantees, express, implied, statutory or in any communication with you, and specifically disclaims any implied warranty of non infringement, merchantability or fitness for a particular purpose. TRI-EDRE does not warrant that the operation of the program will be uninterrupted or error free.
In no event will TRI-EDRE be liable for any loss of use, loss of profits, interruption of business, or indirect, special, incidental or consequential damages of any kind, however caused and under any head of liability, arising out of use of or in connection with the software.

Trademarks

Back-In-Time is a trademark of TRI-EDRE.
All other products are trademarks of their respective companies.

©TRI-EDRE. All Rights Reserved.

TRI-EDRE
22 Place de l’Eglise
83510 LORGUES (FRANCE)
Web site: www.tri-edre.fr • www.tri-edre.com
Email address: contact@tri-edre.fr • contact@tri-edre.com
# Table of contents

Table of contents .......................................................................................................................... 3

**Introduction** .................................................................................................................................. 7
  - Welcome! ........................................................................................................................................ 7
  - Thank you for registering .............................................................................................................. 7
  - Latest version of the software ..................................................................................................... 7
  - Software Installation ..................................................................................................................... 7
  - Uninstalling Software ................................................................................................................... 8
  - Launch and Register Software .................................................................................................... 8
  - Trial version .................................................................................................................................. 8
  - Technical support .......................................................................................................................... 8
  - Contacts ........................................................................................................................................ 8

**Basics** .......................................................................................................................................... 10
  - Time Machine Backups ................................................................................................................ 10
  - Back-In-Time Purpose ................................................................................................................. 10

**Preferences** ................................................................................................................................ 11
  - Updates ....................................................................................................................................... 11
  - Date and Time format .................................................................................................................... 11
  - Automatic Time Machine deactivation ....................................................................................... 12
  - Automatic Mount ......................................................................................................................... 12
  - Unmount when quit ....................................................................................................................... 12
  - Time Machine Volumes ................................................................................................................ 12
  - Time Machine Data ...................................................................................................................... 12

**Main Window** ............................................................................................................................ 13
  - Time Machine Status ................................................................................................................... 14
  - Local Backups ............................................................................................................................... 15

---

Back-In-Time 5 - User manual

3 / 56
Export the contents of a Time Machine backup ................................................................. 50
Compare exported contents ............................................................................................. 50
Delete Time Machine data ................................................................................................ 51
Delete with Time Machine ............................................................................................... 51
Delete with Back-In-Time ................................................................................................. 51

Handle disks of Time Machine Backups ......................................................................... 54
Backup Time Machine data in a disk image ..................................................................... 54
Using old backups ............................................................................................................ 54

Meaning of the icons and color codes ............................................................................. 55

F.A.Q .................................................................................................................................. 56
Welcome!

Thank you for your confidence in purchasing our software Back-In-Time 5! We are certain that you will find Back-In-Time 5 to be the essential companion to Time Machine for Macintosh. Back-In-Time 5 allows you to:

• Browse and recover easily your data in backups.
• Quickly find the version you are looking for.
• Restore your backups easily.
• Copy and restore Time Machine data to anywhere on your Mac using drag and drop, or with the build-in restore function of Back-In-Time.
• Copy data from Time Machine backups made on other Macs or drives.

Thank you for registering

Thank you for registering. You can receive free technical support and be informed of updates and developments of this product, and all the innovations of our production.

If you purchased our software on TRI-EDRE’s web store (download purchase), you are automatically registered, and you do not need to register again.

If you purchased our software from a reseller or within a bundle, please use the registration page on our web site http://www.tri-edre.com.

Latest version of the software

Check our website http://www.tri-edre.com to verify that you have the latest version of this software. If this is not the case, you may download the latest version which allows you to use your serial number.

Note: serial numbers are compatible with all versions of the same main version number: a serial number for version 5.0 can be used with versions 5.1, 5.2, etc.

Note: Back-In-Time can check the latest available version and download it. See Preferences.

Software Installation

In the disk image you downloaded, the application is «Back-In-Time 5». Drag this application in the Applications folder on your startup disk.
Uninstalling Software
To completely uninstall Back-In-Time 5, drag the application Back-In-Time 5 to the Trash, and delete the ~/Library/Application Support/Back-In-Time 5 folder.

Launch and Register Software
Double-click the application icon to launch it. At first launch, the application will ask you to enter the Administrator password (the one you use for each update of the system or applications). Then, a dialog asks you to enter your serial number (provided by e-mail or mail).
This serial number, that is personal, activates all the features of your software.
Keep your serial number in case you need to access technical support or updates.

Trial version
At each launch, you will be asked for a serial number if your version is not registered. To use Back-In-Time in demo mode, wait until the demo button is active. The demo version is fully usable, but is limited to copying and restoring the last Time Machine backup.
You can enter the serial number at any time by selecting “Register your License” in the Back-In-Time 5 menu.

Technical support
Above all, use this guide and our website to check all information on this product and its use. If you do not find the answer to your questions, please contact our technical support by e-mail (see contact information below).
Please have your serial number, your version number, and characteristics of your system ready before initiating contact.

Contacts
If you have comments about this program, problems or issues that are not answered in this manual or on our website - or if you are interested in site licenses of software - please contact TRI-EDRE (specifying the version and serial number of your copy):

by e-mail address: contact@tri-edre.com or support@tri-edre.com
by mail:

TRI-EDRE
22 Place de l’Eglise
83510 Lorgues - France

Web site:
Basics

Time Machine Backups

Time Machine is the backup function integrated in the Mac OS X System. It automatically performs a copy of your disks to an internal or external drive or network - for example, on a Time Capsule or AirPort, or a NAS compatible with Time Machine.

Time Machine provides a restoration function, but has limited options.

Back-In-Time Purpose

Back-In-Time uses your existing Time Machine data, but greatly enhances your restoration capabilities.

Back-In-Time is designed to restore, copy and recover data backed up by Time Machine. Back-In-Time analyzes the contents of Time Machine data and offers options that are not available with Time Machine:

• The ability to check what is backed up, and to compare the current contents of your Mac with backups.
• Restoration or copy by drag and drop to their original location, or any other place of your Mac.
• A view of your backups and the available data: display the number of different versions available for each document, the elements that have been deleted but Time Machine has preserved, etc..
• The ability to open a document in backups directly in an application, or preview it.
• A Powerful browsing of the backups of your data, both through disk space and time.
• The ability to retrieve data that Time Machine has created on other drives or other Macs.
• The ability to display a list of all the elements that have been saved during a Time Machine backup.
• And much more...

In addition, Back-In-Time brings new features to help you best manage the Time Machine data, such as the ability to know the space actually occupied on the Time Machine disk by the backups of the different versions of a document, a file or an application.
Preferences

Select Preferences in the Back-In-Time menu. The dialog has two pages (General and Time Machine Data).

Updates
You can set how Back-In-Time handles updates. Check the box to automatically search for updates.

Date and Time format
You can modify the format used by Back-In-Time to display dates and times.
**Automatic Time Machine deactivation**

It is recommended to disable Time Machine if you want to modify and restore data from Time Machine backups. Check this option if you want Time Machine to be automatically disabled when you run Back-In-Time.

**Important:** The behaviour of Time Machine can be modified according to the Mac OS X System version. You can directly disable Time Machine in System Preferences if you encounter an incorrect behaviour.

*Note: Time Machine will automatically be reactivated when you leave Back-In-Time.*

**Automatic Mount**

If your Time Machine disk is not mounted (for example if you use Time Capsule), make an alias of this disk and it will be mounted automatically when you launch Back-In-Time.

*Note: It will be ejected automatically when Back-In-Time quits.*

**Unmount when quit**

Check this option if you want that Time Machine remote volumes are ejected when Back-In-Time quits.

**Time Machine Volumes**

The options allow you to use the data of Local Backups MobileBackups or "snapshots" (these are temporary data that Time Machine stores on your boot disk if the Time Machine disk is not present) and virtual disks (copy of Time Machine disks).

**Time Machine Data**

Back-In-Time automatically displays the list of Time Machine data present on the disk used for Time Machine backups. Options allow you to select from predefined data. You can choose to display only certain data.
Main Window

The main window is displayed when you launch Back-In-Time.
It has on the left an area of information and access to Time Machine backups, and on the right a navigation area to browse inside these backups.
**Time Machine Status**

The first item in the list shows the status of Time Machine. Select the row of the status to display more information.

You can activate or deactivate Time Machine at any time (you can also open the Time Machine preferences in System Preferences).

*Time Machine Activated: When Time Machine is activated, it may at any time choose to backup and modify data that is used by Back-In-Time. This is generally not a problem for short operations, but if you plan to restore an entire disk or a large amount of data, it is advisable to stop Time Machine during the operation.*
Local Backups

You also have the status of Local Backups. When the Time Machine disk is not available, Time Machine stores temporary data. Data are then copied on the Time Machine disk when it will be available.

With macOS 10.12 Sierra or less, local backups are stored in a MobileBackups folder in the startup disk. You can activate and deactivate the Local Backups on this panel (it is best to keep them enabled, unless your Time Machine disk is always present).

With macOS 10.13 High Sierra or greater on a startup volume APFS, Time Machine stores local temporary data using the APFS's snapshots feature. Local Backups cannot be disabled.

Available Time Machine Volumes

Time Machine backs up your Mac on a volume that can be an internal or external disk connected directly to the Mac, or a Time Capsule or a network drive (in this case, the Time Machine data are saved for every Mac in a specific disk image).

Back-In-Time is able to simultaneously take into account multiple disks containing Time Machine backups, for example your current Time Machine disk, old Time Machine disks, the Time Machine disks used on other Macs or Time Machine backups located on remote disks, Time Capsule, NAS, etc.

Volumes containing Time Machine data are displayed in the "Time Machine Volumes" part of the list:

Remote Time Machine Volumes: A disk containing disk images (Time Capsule, etc.) is displayed with a blue background.

Note: Select one of these disks and Back-In-Time will display the disk images «sparsebundle» located at the root of the disk. Double-clicking will mount the disk image, and Back-In-Time allows you to view, search and retrieve Time Machine data contained in the disk image.

Local Backups: Back-In-Time can display the Time Machine data in the local backups: MobileBackups under macOS 10.12 or less, or "snapshots" when running on a boot disk with APFS format.

Data contained in the Local Backups are displayed with the Time Machine data in the backups browser.

Time Machine Volumes: The mounted disks and disk images containing Time Machine data are displayed with a green background. Select to display more information about the disk and the backups.

Back-In-Time displays the machines and the disks stored in the volume as well as a list of the backups.
Virtual Time Machine Volumes: Virtual disks are displayed with an orange background. Select to display more information about the disk and the backups.

Note: Virtual disks are images of Time Machine disks that can be created by Back-In-Time. They have a much smaller size than the original disks because they contain only the directory of the disk without file contents. Virtual disks are used by Back-In-Time to browse and search in Time Machine data without the original disk is mounted. Virtual disks are convenient to view other Mac or remote disks backups without having the original data. Once you find the document you are looking for, you will need the real disk to recover the original file.
Organization of Time Machine backups

This section gives some indicative information on the operation of Time Machine. The organization could possibly be changed by Apple in a future version of macOS.

In a Time Machine disk, backups are organized in a «Backups.backupdb» folder at the root of the disk (or disk image). From the Finder, if you open a Time Machine disk, you can see something as follows:

![Image of Time Machine disk structure]

The «Backups.backupdb» folder contains a folder for each machine that is backed up. In general, there is only one machine but if you have used the same Time Machine disk for more than one computer, you can have multiple machines stored on your Time Machine disk.

For a given machine, there is a folder for each backup. The name of this folder gives the date and time of the backup.

In each of these backups, there is a folder for each of the saved disks. In this folder, there is a copy of the original disk (with the same folders organization).

Changes introduced with macOS 11 Big Sur

Since macOS 11 Big Sur, Apple has changed the structure of backups. A Time Machine volume can only back up one Mac. There is no longer a "Backups.backupdb" folder or folder for each machine. At the root of the Time Machine volume, there are therefore the folders for each backup (their name indicates the date and time of the backup).

![Image of Time Machine volume structure]

Back-In-Time displays these "new version" disks in the "Time Machine Volumes" list with a specific icon (with a red dot):

![Image of HD Time Machine icon]

Note: If the Time Machine disk was created with an older version of macOS, the Backups.backupdb/Machine/Date/Contents... structure is kept and Time Machine continues its backups with the old structure.
Available Time Machine Data

Back-In-Time automatically analyzes the content of any Time Machine drive which is mounted, and adds the available data in the list. Generally, this list will contain your Home, Documents and Applications folders, your startup disk and other specific data (Mail, Address Book, etc.).

You can specify in Preferences the predefined data from the startup disk to display in the list. Back-In-Time locates in the Time Machine backups the corresponding data of your internal disk backed up by Time Machine. Any other data stored on other disks used by Time Machine is also displayed.

Important: If Time Machine makes its backups to a remote drive (Time Capsule, etc.), you must mount the disk for Back-In-Time can read the data it contains. Mount this volume, and then open the disk image (of type .sparsebundle).

You can refresh the list of Back-In-Time with the button located above the list:

Multiple backup disks for a same disk and same machine: If Back-In-Time detects multiple Time Machine disks containing backups of your data, they are automatically taken in account for browsing and restoring.

The Time Machine disks are in parentheses in the list on the left:

The two backup disks are also displayed top of the browser:
Note: This can be very useful if you replace the disk for Time Machine. In this case, Time Machine does not know about the data backed up in the old drive (it starts again from zero with the new disk). Back-In-Time can search and retrieve data in the old disk (if still connected and mounted) in addition to data on the new disk.

**Backups of other disks and other machines:** If Back-In-Time detects other volumes than the startup disk and extra machines saved in the Time Machine disks connected to your Mac, they are displayed in the list and grouped by machine.

For example, here is a Time Machine disk that contains backups of two machines, "iMac 2016" and "MacBook Pro 2017". Time Machine has saved the data of three disks for the "MacBook Pro 2017" machine:

Select this Time Machine disk on the left to get the information about the machines and disks backed up in this disk:

You find these machines and their disks in the list on the left. You can select a disk to view the content in backups.
At the end of the list are your favorite items and the recent items, so that you can easily access their data.

**Time Machine data related to a particular folder**

You can access the data through one of the following methods:
- Select one of the items of the left list.
- Drag and drop a folder on the Back-In-Time window or its icon in the Dock.
- Use the Open File menu (Command-O).

Back-In-Time shows the data for this folder.
Current contents of the Mac

To view the current content in your Mac, choose this display mode:

The center column displays the content on the disk (the current content present in your Mac).
Certain items could be missing in the backups because you have excluded them in the Time Machine options, or because it is a recent item that have not yet been backed up. A red dot indicates the items that are not in the backup.

Browser of the contents of backups
The browser on the right side of the window displays the data backed up by Time Machine for a particular folder or file. You can search for old versions of your data, and copy and restore files and folders.

Restore data from Time Machine
You can restore a particular folder or file with a drag and drop, or with the button "Copy Selection...". You can also restore the entire content. Click «Restore/Copy all», or select «Restore» from the File menu.
You access the Back-In-Time browser by selecting an item from the list on the left, the Open function from the File menu, or if you drag and drop a disk, folder or file directly on the icon of Back-In-Time or its window.
**Current content of your Mac**

The current content (for your Mac) is displayed in the column in the center. This makes it easy for you to control what is backed up or not by Time Machine and the recent items that have not yet been saved.

You can show or hide the contents of your Mac via the menu Browser > Show Original Content or using this button:

You can use the browser options to display in the list the invisible items and the contents of packages (applications, for example).

The list displays the contents, indicating the items that are not found in backups (indicated by a red dot and the words "not in backups"), either because they are excluded (in Time Machine options), or because they are newly created and have not yet been backed up by Time Machine.

![Current contents of:](image)

**Tips:** Double-click a folder to display its contents (Mac content and content in Time Machine backups).

You can access an item in the Finder by opening the context menu with a Control-click (or right click) on the item.

**Contents of the Time Machine backups**

Back-In-Time analyzes the Time Machine disk(s) and searches data corresponding to the selected item. It reconstructs the history found in the contents of all backups and recreates the historical content backed up. The data saved by Time Machine are displayed as a list in the right part.

At the top you can select the date of the backup by moving the cursor (default is the most recent backup displayed). The list displays the contents at this date.
Display Modes and Display Options

The Simple Mode hides most of the options and provides settings to their default values. There is an option to show or hide deleted items (those that do not exist in the current backup, but were present in a previous backup) and a search field (to filter the displayed items by the name).

The More Options mode shows all options.

You can show or hide in the list the invisible files and folders, as well as the contents of packages and applications (which are considered in this case as folders containing files and sub-folders).

When Back-In-Time finds in the backups several different versions of a document, it shows the number of versions in a red dot. Option Only items with multiple versions limits the display of documents that have more than one version backed up by Time Machine.

To easily find the desired version, the triangle shows the different versions backed up (with their dates).
Deleted items (those that are not displayed in the backup, but were present in a previous backup) are displayed with a “Trash” icon. The **Only Deleted Items** option displays only those items in the list.

You can show more information in the list, such as the **size of the items** and color codes indicating the **status of the item for each backup** (modified - rose - or unchanged - yellow). Other display options shows the **space used** in backups by all the different versions of a document or folder.

**Display data backed up on multiple Time Machine disks**

If the data of a disk in a machine was backed up on multiple Time Machine disks (for example because you have changed your Time Machine disk), Back-In-Time automatically displays versions of data backed up using the different available disks.

*Backups for each Time Machine disk is indicated here as "HD Time Machine A 1" (Time Machine disk for older backups) and "HD Time Machine A" (for the last backups).*
The different versions of the same file are searched inside each of the Time Machine disks. You can view and restore versions of documents backed up in these disks (just as if it were a single disk).

**Important!** The name of the machine and the disk must be identical in the different Time Machine backup disks so that Back-In-Time can associate them. If the name of the machine or the name of the disk is different, the backups are considered backups of different disks. Note that you can link them together (see below).

### Linking a disk to other backups

Time Machine organizes its backup by machine and disk. If you change your startup disk or change its name, if you replace your motherboard or your Mac, or if you change the disk used by Time Machine, Time Machine creates a new different backup unconnected with the previous ones.

Back-In-Time displays in the left the list of the various machines detected on the disks containing Time Machine backups. Back-In-Time also displays the disks of each of these machines. You can navigate through each disk and retrieve data.

But if you have changed your disk or computer, it's a shame not to be able to access your current disk and its predecessor, as if it were a single disk.

**Combine multiple disks**

Back-In-Time provides a unique solution to this problem.

Back-In-Time can link the Time Machine backups of different disks or machines, and display their content in the browser like a single disk.

To associate these disks, double-click a disk in the left list (or select it and click on the Links button, or choose "Link disk to other backups" in the Browser menu).

A links editor is then displayed:
You add the desired disk with the pop-up menu located below the list:

To remove a disk from the list, select it and click the button.

The disks linked to other backups are indicated by a double disks icon displaying the number of disks (including the disk itself).
Note: You can disable or enable at any time the display of disks linked with the function "Enable concatenation" in the Browser menu. When disabled, the link icon is grayed.

The different versions of the same file are searched inside each of the Time Machine disks. You can view and restore versions of documents backed up in these disks (just as if it were a single disk).

The Backup Selection

The top area displays the dates of all backups that Back-In-Time has detected for the data to analyze. These are the Time Machine backups, represented by their execution dates.

The list of contents

The list displays the folder contents analyzed. The contents of folders, or the different versions of a document are found by clicking on the triangle to the left of each item in the list.
**Multiple versions**

Back-In-Time displays all versions of the document kept by Time Machine, including the number of versions (in a red dot) and the total size of all versions (in a blue background for files, and a green background for folders, applications and packages) from the beginning to the selected current backup.

![Backup content]

An orange dot to the left of the icon indicates the elements that are different in the backup (compared to the current content in the Mac). Their name is also bold. An option can display the size. The list can be sorted by size in the Browser menu.

*Note: The size is the sum of all different versions of the files (it is the real space occupied by all the backups of this file or folder in the Time Machine disk).*

*Note: The size of folders requires much more calculations and analysis, and can be long for large folders. It is disabled by default but you can activate the option of calculating the size of folders. You can also obtain the size occupied by a particular folder by selecting it and using the Browser menu (or the contextual menu).*

By opening the triangle to the left, Back-In-Time displays the different versions of the document (highlighted with a green background), with their size and date.

**Color codes**

The cursor also displays, by color codes, information about the selected item in the list. For each backup, you can tell if the file exists or not (if it does not exist in this backup, the area of the cursor is blue-gray), and whether a new version (in red) or a version which did has not been modified (yellow).

![Color codes]

**Status in each backup**

You can choose to display, as a background for each item, the backup that corresponds to each new version. As you can see below, each red bar corresponds to the backup of a new version.
Deleted items

Deleted items (which are no longer in the selected backup, but a version of which exists in an older backup) are displayed on a gray background with a trash can icon.

In this case the slider indicates how many backups may be found. Move the mouse cursor at the location to display the date of the backup that contains this element.

Refresh the contents of the list

Click the button on the top right of the list to refresh its contents:

Preview

You can display a preview of a document and each of its versions. Select the document and press the space bar to view its contents (or use the Selection menu, or the contextual menu).

Open and display in an application

As you would from the Finder, you can open and view a document or one of its versions by dragging and dropping it on the icon of an application in the Dock, or directly in a window of the application (if it accepts the document type).
Thus, you don’t need to restore a document to read or use it (Caution, you can not save it in the Time Machine backups as the system prevents from writing in Time Machine backups).

**Information window**

You can view an information dialog for each document and each of its versions. Select the document and use the Selection menu (Cmd-I), or the contextual menu.

**Contents Comparison Dialog**

Select two files or two versions of the same file and use the Selection menu (Cmd-Option-I). Back-In-Time graphically display the identical parts (green) and differences (in red).

![Files Comparison](image)

**Display Options**

Display options modify the list of displayed items and the presentation. These options are available in the "Browser" menu and in the main window (mode «More Options...»).

![Display Options](image)

Options can display:
• **Deleted items:** If the box is checked, items that are unavailable in the selected backup but that exist in an old backup, are shown with gray background and a trash can icon to the right.

• **Search field:** The only elements whose name matches the letters entered in the search box. 
*Note: The space is used as separator. Example: Type "sept 2009" to display only files and folders whose name contains "sept" and "2009".*

• **Invisible items:** They are displayed with an orange background.

• **Package contents:** If the box is checked, the content of applications, bundles and other packages is displayed.

• **Items that have multiple versions only.**

• **Deleted items only.**

• **Size of items:** Display the size of each file and folder in the current backup.

• **The status in backups:** Each row is displayed with a background which indicates with colors the backups containing a new version of the item.

• **Size of Backups:** Display the size used on the backup disk by all the different versions of the file.

• Calculation of the **space occupied by each folder** in the backup disk for all the backups of this folder.

**Drag and drop to restore**

It's the easiest way to quickly retrieve an item in backups.

To copy or restore a file, document or one of the versions available, you drop from the Back-In-Time window to the desired location on the Desktop or a folder.

You can copy any file or folder available, even the previous versions of backups or items that have been deleted but you can find an older version.

**Restoration**

You can also restore the entire folder or selected items by using the buttons at the bottom of the window.

Previously, you can choose the backup that will be used for the restoration.
Time Machine Virtual Disks

Back-In-Time allows you to create virtual disks. Virtual disks are "images" of Time Machine disk, containing the list of contents (hierarchical folders structure and files list) with the modification date and the size of each file.

The contents of a virtual disk is displayed in the main window like a Time Machine disk. You can browse and search a virtual disk.

A virtual disk has a very small size compared to the original. By cons, it contains no data (document content). The virtual disk is used to determine where are the data you want. To retrieve the data, you need the original disk.

Note: You can create as many virtual disks as needed, for example for old Time Machine disks, disk images of a Time Capsule, backups of other Macs, etc. A virtual disk can be created on a Mac and copied to another Mac for use.

Create a virtual disk

To create a virtual disk, select the Time Machine disk you want to copy (in the list of volumes of Back-In-Time) and open the menu Tools > Create Virtual Time Machine Disk....

A dialog asks for confirmation and a progress window shows you the progress of the copy.

Note: You can stop the creation of the virtual disk at any time. It will contain the data already analyzed and you can resume its creation later.

Important! Let Back-In-Time open during the creation of the virtual disk.

Virtual Disks display

The "Use Virtual Volumes" option should be checked in the Preferences (Panel "Time Machine Data").

Virtual disks are displayed in the list on the left, like normal Time Machine disks. Their name is in italics and the background color is orange.

Important: A virtual disk is displayed only if the original disk it replaces is not mounted.

Note: If the virtual disks are not displayed, check in the Preferences if the option is checked.

Navigation and search in a virtual disk

Navigation and search the contents of a virtual disk is identical to that of a normal Time Machine disk.
A virtual disk can be combined with a normal Time Machine disk. For example, if you changed the Time Machine disk, and you create a virtual disk from the old disk, Back-In-Time automatically detect that these backups are for the same machine and you can navigate through all the backups of these two disks.

A virtual disk is displayed in orange (for example "SSD TM HD" in the screen copy).

Important: You can not copy data from one virtual disk. It contains no actual files are saved, only the list of contents.

**Updating a virtual disk**

It may be necessary to update a virtual disk if its creation was interrupted, or if new backups have been added to the original Time Machine disk.

To update a virtual disk, mount the corresponding Time Machine disk and select it in the list.

Open the menu Tools > Create Virtual Time Machine Disk...

A dialog will prompt you to update the virtual disk by adding new backups (backups already analyzed remain unchanged in the virtual disk).

Important! Let Back-In-Time open during the update of the virtual disk.
Location of virtual disks

Virtual disks created by Back-In-Time are stored in the ~/Library/Application Support/Back-In-Time 5/Virtual Time Machine Disks/ folder. They have the same name as the original disk.

![Virtual Time Machine Disks]

- SSD TM HD
Space occupied on the Time Machine backup disk

It can be very useful to know the space occupied on the disk by all the Time Machine backups of a file, an application or a folder:

• To optimize the space occupied on a Time Machine disk that becomes too full.
• To know the items that take up more space on the disk.
• To find whether it is wise to keep all old versions of applications.
• To get an idea of the occupation of a large file (or a set of data) that is modified regularly.

Back-In-Time offers powerful features to meet those needs. But first, let's see how Time Machine organizes the data it has stored.

Disk occupation by the Time Machine data

When Time Machine makes the backup of a disk, it creates a new full backup with the entire contents of this disk. All the unchanged files exist therefore in the two backups, as you can see by looking at how is organized a Time Machine disk.

To optimize the space occupied, Time Machine physically records on the disk only one version of each file. Thus, if an unchanged version of a 10 MB file is saved in 25 successive backups, it will occupy in reality only 10 MB on the disk. To simplify, the duplicates are links to an unique location (the reality is somewhat more complex).

Size of a file or a folder

Each item has a size. If the item has not been modified, it will be the same size in each backup (but it will only occupy a single space on the disk).

In the graph, the size of an item is specified for each backup by a dotted line.

To get the size of an item in the current backup, click on this item. The size is displayed at the bottom of the list, possibly with the number of files if it is a folder or an application.

Note: The size displayed is for the element in the current backup. This size does not account for possible duplicates in other backups.
**Occupied space displayed by Back-In-Time**

The space occupied by the different versions of a file, a folder or an application can be displayed for each item.

In the example below, the backups contain twelve different versions of the file "Tri-BACKUP 8-Info.plist" (the last version is 5.58 KB and the total of the 12 versions occupies 67.02 KB).

The folder "source" contains different items for a total of 6.49 MB.

![Image showing space occupied by files and folders]

*Note: An application, like a folder contains sub-folders and files. Files may be identical from one version to another. Back-In-Time calculates the actual space occupied by taking account of any unchanged files.*

*Note: Back-In-Time does not show the number of versions for the folders, but you can see the modification dates of the various versions of the folder "Goodies" represented by a red bar.*

Back-In-Time also displays the size occupied by each version, as in the example below:
You can obtain the space occupied by only some versions. Simply move the cursor to the desired backup date, as in the example below:

The buttons at the top left of the list are displaying a graph that gives with red bars, the space used for each backup.

You can also display the evolution of the space occupied version after version, as below:
To get the size of an item at a particular time and the space occupied on the backups disk, move the mouse cursor on the graph. In the example below, the version had a size of 101 MB the 20th of July and the backups of all versions until July 20 occupied a space of 436 MB on the disk:

![Graph showing Time Machine data and backups](image)

**Practical Example**

In the screenshot below, Back-In-Time provides a wealth of information about the backups folder "Back-In-Time U.S. (manual)." Firstly, if you select this folder, Back-In-Time displays its size (12.79 MB) and the number of items (4) in the current backup (the one selected by the cursor of the dates of backups).

This folder is found in 13 successive backups but we see that the actual space occupied on the Time Machine disk is 37.72 MB. Indeed, there is only one version of the file "Back-In-Time. pdf", then 13 identical versions of this file in the backups occupy only the size of a single copy (2.88 MB).

By cons, there are 5 different versions of the file "Back-In-Time.pages". The size of the last version is 7.02 MB, for a total space occupied on disk of 31.96 MB.

![Screenshot showing Back-In-Time backups](image)
Browser Features

You have access to various tools from the Browser, Selection and Copy/Restore menus (some functions are also accessible through the contextual menu).

**Browser menu**

The first item shows or hides the list of the current contents of the Mac.

The next group changes the display options (invisible items and deleted, and the contents of packages).

The next group manages the display of the size occupied by the backups.

The next group can manage the relationship of a disk with several backups.

The latest features in this menu allow you to move through the backups with the keyboard shortcuts.

**Selection menu**

Various functions are available for the selected item:
• Preview (Quick Look), also accessible with the spacebar.
• Information (displays the information dialog).
• Reveal in Finder.
• Open (by its default application).
• Delete (from the Time Machine backup).

**Copy/Restore menu**

• Copy (with the copy/restore function).
• Copy all versions (with the function to regroup all different versions and copy them in a folder or disk).

**Open a subfolder**

You can open and view the contents of a file from the list by clicking on the triangle. You can also double-click a folder to open it in the browser.

These buttons open the parent folder, or the selected folder: (therefore go up or down the hierarchy).

**Drag and Drop Copy**

You can copy any item by dragging and dropping at the location of your choice (on the desktop, in a folder, etc.).

**Open with a drag and drop**

You can open a document in the application of your choice by dragging it to the icon of the application.

*Note: If you modify this document, you cannot save it to its current location. You need to save it to another location.*
Back-In-Time Restoration

To restore data, select one or more items in the browser window and click the «Copy selection ...» button, or click «Restore/Copy All...» to restore the entire folder. This is the window where you set up and launch a restoration:
Note: You can also copy/restore a file or folder by dragging from the Back-In-Time browser and dropping to the location of your choice on the Desktop or a folder.

What is restored?
The selected items are shown at the top of the window.
If available, you can choose the date of the backup to restore. Available dates are the dates of backups detected by Back-In-Time in the disk used by Time Machine for backups.

The data will be restored as they were at the chosen date.

The Destination Location
You have to choose where the restoration will copy the files and folders. It can be either the original location, or any location in one of the available disks.
Caution! Items that were not in the backup at the date chosen will be removed from the destination (if they exist there). The different items (newer or older) will be replaced. The files that were not amended remain unchanged (they are not copied).

Restoration Options
The restoration will modify the contents of the destination folder if it is not empty.
Use the options available to choose what should be made of elements found in the destination before the restoration. These can be removed, put in the Trash, renamed (with adding a suffix to their name) or left to their location (if not overwritten by files restored).

Preview the result of the restoration
The right part shows a summary, and the top list displays the items that will be copied to the destination.
Below, you have two columns representing the destination before and after restoration. The color codes indicate what will happen to each item, depending on the options selected.

Important! Be sure to check out the expected result before starting the restoration. All items deleted or overwritten can not be recovered. Optionally, run a Time Machine backup before the restore operation to have a backup of the current status.
Copy All Versions

Back-In-Time can analyze all the Time Machine backups and copy all the different versions of each file with a single operation. In the Copy/Restore menu, you can "Copy all versions..." of the entire currently displayed folder, or only those of the selected items.

The two popup menus select the backups from which data will be copied to the destination.
You can choose to search the different versions of each file in all backups or only in some backups.

The copy will create an identical structure of folders and subfolders (same as original).

For each file, the first version will be copied with the original name. The other versions will be copied either with a modified name (adding the date of backup), either with the original name, but in a subfolder (whose name is composed of the date of backup).

Important: Only the versions that are different are copied. If several identical versions of a document are in different backups, only one will be copied.

Here is an example of the result:

This grouping of all versions feature can have multiple uses as, for example, bring together all the different versions of documents related to a particular project, or for the purpose of archiving.
Other Features

List of items backed up

Back-In-Time can search and view all the files that were saved in a special Time Machine backup. You can search the entire disk backups, but backups in a particular folder.

To perform a search:

- For a disk or a particular backup, open the Time Machine Data information window, select the desired backup in the list and click the button at the bottom of the window.
- You can also, in the Back-In-Time browser, select an item from the list on the left or open a particular folder. Then select «Show Items Backed Up» from the File menu.

The settings dialog is displayed.
- Choose the date of the backup to scan in the pop-up menu.
- Also choose the method: either searching for items that were saved during a particular backup, or a comparison of differences in the two selected backups.

Once your settings are correct, launch the search.
Note: The search can be quite long. You can interrupt it at any time, or skip the folder being analyzed.
Back-In-Time displays the items found in the form of a hierarchical list. Only different files are displayed (those that Time Machine has saved specifically). To the right of each folder is shown the number of files and size of saved items, and the size of each file.

You can **export** the results of the search in a text file. Click the Export... button.
You can restart a new search by clicking the Search... button.
Export the contents of a Time Machine backup

You can export in a text file the list of the contents of a folder for a particular backup. This function is accessible from the File menu. A dialog opens where you can select the folder to export and the date of backup.

Click "Export" to choose the location where the text file will be created and let Back-In-Time analyze the backups and create the text file. You can then further study or transmit to others the files obtained or analyze them with specific tools.

You can also use Back-In-Time to compare two exports.

**Compare exported contents**

This function is accessible from the File menu. It can compare two text files created by the export function of Back-In-Time. It lists the differences between the two files and detects missing or different items.
Delete Time Machine data

IMPORTANT! It is advisable to delete data in backups directly with Time Machine after using Back-In-Time to detect the data to be deleted (those that can free up space).

Delete with Time Machine

To do this:
- Enter in Time Machine from the Finder.
- Select the items you want to delete.
- Use the pop-up menu with this icon and select the Delete function.

Delete with Back-In-Time

With Back-In-Time, you can delete data stored in backups on the Time Machine disk.

You can delete a single version of a file in a particular backup, or all versions of one or more files or folders in all Time Machine backups.

This is a great way to clean the Time Machine disk by removing data that had been saved but you're definitely not going to need. It is also a way to make room on the Time Machine disk.

WARNING! Any removal of data in a Time Machine disk is irreversible. Be very careful using this function.

Note: Data are suppressed only in the Time Machine backups. The originals of your disks are not affected by this function.

To delete data, select the files and folders to delete in the browser and use the Remove function in the Selection menu (or in the contextual menu). A dialog opens:
You can choose to delete:

- A single version only: removes only the version found in the backup currently displayed in the browser.
  
  *Note: If no version is in the current backup (item indicated by a Trash icon), the version displayed in the list will be removed (it corresponds to an older backup).*

- All versions: delete all versions of the selected item in the Time Machine backup in progress and in all Time Machine backups older.
  
  *Note: If the current backup is the last backup performed by Time Machine, all versions of files and folders will be removed from Time Machine backups.*

- In a set of backups: delete all items in a set of Time Machine backups from the current backup to that of a chosen date.
  
  *Note: If you delete all backups of an item always present on your hard disk, it will be backed up again at the next Time Machine backup, and then appear again in Back-In-Time (but the latest version only).*
Be aware of: To save space on the disk by successive backups, Time Machine saves once (in a single physical disk location) each new version of a file, although if this version seems even recorded in each subsequent backups.

To free disk space, you must delete all occurrences of a version of a file. As long as one of the backups contains this file, physical space occupied by the file will not be released.
Handle disks of Time Machine Backups

Time Machine does not allow to transfer backups to a larger drive or group Time Machine backups. Moreover, Time Machine deletes older backups when the disk is full. If you want to keep your Time Machine backups, you can regularly change Time Machine disk, and keep the old disks. You can also regularly make a copy of your Time Machine disk and archive it in a disk image. Once the copy has been made, you can erase the Time Machine disk to start new backups. In these cases, Back-In-Time will allow you to use your old disks and disk images to find and recover your old backups.

Backup Time Machine data in a disk image

To create an archive disk image, open the application "Disk utility", select your Time Machine disk and create a disk image of this disk (File menu). The format can be "read only" or "compressed" because the contents of the disk image will not be changed.

Using old backups

When you need to access your old backups, mount your old disks or your disk images. Back-In-Time recognises these Time Machine data and include them automatically into the browser.
Meaning of the icons and color codes

Virtual volume: represents a virtual disk created by Back-In-Time (copy of the list of the contents of a Time Machine volume).

Linked disks number: indicates the number of connected disks (disks linked to display their contents as if it were a single disk).

Button to update the list of content.

Item that does not exist in the backups.

Old item: indicates that the item in the backup is different in the original disk (for example if Time Machine has not yet saved it).

New item: the current backup contains a new version of this item (different from the one in the previous backup).

Deleted item: do not exist in the current backup but exists in another backup (can be an item that has been deleted in the original disk).

Number of versions: the number of different versions available in all of the backups.

Opens the list of versions of the item. The list displays all versions on a green background, as in this example:

![Example of list of versions](data.png)

Status of the item in each backup: the pink color indicates a new version, the yellow color a version that is unchanged.

Size occupied by a folder (the versions of its content) in backups.

Size occupied by a file (its versions) in backups.

Items with different content (comparison).

Items with different dates (comparison).
F.A.Q

Q: Why do I have a message indicating that the Time Machine data is not available?
A: In handling the data corresponding to the Time Machine disk or folder to analyze, Back-In-Time search in the mounted disks recognized to be used by Time Machine.
   If the folder that you do scan has not been backed up by Time Machine (for excluded, or being on a volume that is not backed up), you get this message.
   Similarly, if Time Machine uses a remote drive for its backups (Time Capsule, etc.), you must mount the disk and then mount the disk image used by Time Machine.

Q: Why is it that Back-In-Time advises me to turn off Time Machine for the restoration?
A: When Time Machine is active and running a backup, it modifies its data, adding features and deleting others. If you copy a file or folder by dragging and dropping, there is usually no problem. By cons, if you restore or copy a disk or a large amount of data, it is better to stop Time Machine for this operation.

Q: I changed the Time Machine disk to a larger one. Is it possible with Back-In-Time to recover data residing on the old disk?
A: Yes. Back-In-Time search all mounted disks containing data Time Machine, and presents the contents of the old and the new disk. You can retrieve and copy data from both the old and the new disk.